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Introduction  Learning Guide # 14  

   This learning guide is developed to provide you the necessary information 
regarding the following content coverage and topics – 

 

 Retrieving Information 
 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 

 Existing database is accessed and required records located 

 Simple query is created and required information retrieved 

 Query with multiple criteria is developed and required information retrieved 

 Data are selected  and appropriately displayed  
 

1: Learning Instructions 

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described in number 3 to 18.  

3. Read the information written in the ―Information Sheets 1‖. Try to understand what 

are being discussed. Ask you teacher for assistance if you have hard time 

understanding them. 

4. Accomplish the ―Self-check 1‖ in page 5.  

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you 

finished answering the Self-check 1). 

6. If you earned a satisfactory evaluation proceed to ―Information Sheet 2‖.  

However, if your rating is unsatisfactory, see your teacher for further instructions 

or go back to Learning Activity #1. 

7. Submit your accomplished Self-check.  This will form part of your training portfolio. 

8. Read the information written in the ―Information Sheet 2‖. Try to understand what 

are being discussed. Ask you teacher for assistance if you have hard time 

understanding them. 

1. Accomplish the ―Self-check 2‖ in page 9.  

2. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you 

finished answering the Self-check 2). 
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3. Read the information written in the ―Information Sheets 3 . Try to understand what 

are being discussed. Ask you teacher for assistance if you have hard time 

understanding them. 

4.  Accomplish the ―Self-check 3‖ in page 12.    

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you 

finished answering the Self-check 3). 

6. Read the information written in the ―Information Sheets 4 . Try to understand what 

are being discussed. Ask you teacher for assistance if you have hard time 

understanding them. 

7. Accomplish the ―Self-check 4‖ in page 14. 

8. Read the ―Operation Sheet 1‖in page 15. and try to understand the procedures 
discussed. 

9. If you earned a satisfactory evaluation proceed to ―Operation Sheet 2‖ in page 17.  
However, if your rating is unsatisfactory, see your teacher for further instructions 
or go back to Learning Activity #1. 

10. Read the ―Operation Sheet 2‖ and try to understand the procedures discussed. 
11. If you earned a satisfactory evaluation proceed to ―Operation Sheet 3‖ in page 

37.  However, if your rating is unsatisfactory, see your teacher for further 
instructions or go back to Learning Activity #1. 

12. Do the ―LAP test‖ in page 50 (if you are ready). Request your teacher to evaluate 
your performance and outputs. Your teacher will give you feedback and the 
evaluation will be either satisfactory or unsatisfactory.  If unsatisfactory, your 
teacher shall advice you on additional work. 
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Information Sheet 1 Accessing & Locating Required records 

Locate specific records in a database: As your database grows, locating specific 
records will involve more than a quick glance at a datasheet. In this article, learn five 
ways to locate specific records based on your needs. 

                Browse through all records You can browse through records by using the 

TAB key when you want to move through one record at a time, in order, to locate a 

specific record. You can also browse through records in a table in Datasheet view 

using the record navigation buttons. The record navigation buttons are available at 

the bottom of the table or form. 

 

                  Browse through all recordsYou can browse through records by using the 
TAB key when you want to move through one record at a time, in order, to locate a 
specific record. You can also browse through records in a table in Datasheet view 
using the record navigation buttons. The record navigation buttons are available at 
the bottom of the table or form. 

 

              The techniques that you can use to search and filter records are very useful 
for finding specific records for the case at hand. However, you might want to perform 
the same search or filter operation regularly. Instead of reproducing a set of search 
and filter steps every time, you can create a query. A query is a powerful and flexible 
way to locate specific records because it lets you perform customized searches, 
apply customized filters, and sort records. You can build your own queries to help you 
focus on specific records and to answer specific questions. Once created, a query 
can be saved and reused, and can also be used in building forms and reports. 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

1. You can browse through records by using the--- key(2) 

A. TAB 

B. ALT 

C. Delete 

D. None 

2. The -----buttons are available at the bottom of the table or form.(2) 

A. record navigation 

B. Save button 

C. A&B 

           . 3. ---is a powerful and flexible way to locate specific records & customized                  

searches     

A. True 

B. False 

 

 

  

 

 

 

 

 

 

 

 

Information Sheet 2 Creating Simple Query to Retrieve Information 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 2 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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 A query is a request for data results, for action on data, or for both. You can use a 

query to answer a simple question, to perform calculations, to combine data from 

different tables, or even to add, change, or delete table data .A query is a derived 

item in the database meant 

 to answer specific questions that relate to the information in the database. It is the 

means to retrieve relevant information in one or more tables.  

 2.1Types of Queries 

 Select Query 

 The select query is the simplest type of query and because of that, it is also 

the most commonly used one in Microsoft Access databases. 

 A select query is the most common type of query.  

 It retrieves data from one or more tables and displays the results in a 

datasheet where you can update the records (with some restrictions).  

 You can also use a select query to group records and calculate sums, 

counts, averages, and other types of totals. 

 It can be used to select and display data from either one table or a series of 

them depending on what is needed. 

 In the end, it is the user-determined criteria that tell the database what 

the selection is to be based on.  

 After the select query is called, it creates a "virtual" table where the data 

can be changed, but at no more than one record at a time. 

 Action Query 

 Action queries are very popular in data management because they allow 

for many records to be changed at one time instead of only single records 

like in a select query. 

 When the action query is called, the database undergoes a specific action 

depending on what was specified in the query itself.  

 This can include such things as creating new tables, deleting rows from 

existing ones and updating records or creating entirely new ones. 

 Four kinds of action queries are: 

 Append Query 

 An append query adds a group of records from one or more tables 

to the end of one or more tables. For example, suppose that you 

acquire some new customers and a database containing a table of 

information on those customers. To avoid typing all this information 

into your own database, you'd like to append it to your Customers 

table. 
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 Delete Query  

 A delete query deletes a group of records from one or 

more tables. For example, you could use a delete query to 

remove products that are discontinued or for which there are 

no orders. With delete queries, you always delete entire 

records, not just selected   fields within records. 

 Make Table Query  

 As the name suggests, it creates a table based on the set 

results of a query.A make-table query creates a new table 

from all or part of the data in one or more tables.Make-table 

queries are helpful for creating a table to export to other 

Microsoft Access databases or a history table that contains 

old records.  

 

 Update Query  

 Allows for one or more field in your table to be updated. 

 An update query makes global changes to a group of records 

in one or more tables.  

 For example, you can raise prices by 10 percent for all dairy 

products, or you can raise salaries by 5 percent for the 

people within a certain job category. With an update query, 

you can change data in existing tables. 

 Parameter Query 

 In Microsoft Access, a parameter query works with other types of 

queries to get whatever results you are after.  

 This is because, when using this type of query, you are able to pass 

a parameter to a different query, such as an action or a select query.  

 It can either be a value or a condition and will essentially tell the 

other query specifically what you want it to do. 

 It is often chosen because it allows for a dialog box where the end 

user can enter whatever parameter value they wish each time the 

query is run. The parameter query is just a modified select query. 

 A parameter query is a query that when run displays its own dialog 

box prompting you for information, such as criteria for retrieving 

records or a value you want to insert in a field.  

 You can design the query to prompt you for more than one piece of 

information; for example, you can design it to prompt you for two 

dates.  

http://www.databasedev.co.uk/delete_query.html
http://www.databasedev.co.uk/make-table-query.html
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
http://www.databasedev.co.uk/update_query.html
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/OFFICE11/1033/acmain11.chm::/html/acrefTypesOfQueriesYouCreateIn.htm
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 Access can then retrieve all records that fall between those two 

dates. 

 Parameter queries are also handy when used as the basis for forms, 

reports, and data access pages.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Self-Check -2 Written Test 
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Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

1. .--- is a request for data results, for action on data, or for both(2) 

A. A query 

B. Table 

C. Form 

D. None 

2. --- deletes a group of records from one or more tables (2) 

A. A delete query 

B. Append Query 

C. Parameter query 

3. Allows for one or more field in your table to be updated.(2) 

A. Update Query  

B. Parameter query 

C. Select query 

            

 

  

 

  

  

 

 

 

 

 

 

Information Sheet 3 Developing Query With Multiple Criteria 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 

 

http://www.databasedev.co.uk/update_query.html
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3.1 Introduction to query criteria 

A criterion is similar to a formula — it is a string that may consist of field references, 

operators, and constants. Query criteria are also referred to as expressions in 

Access. 

The following tables shows some sample criteria and explains how they work.  

Criteria  Description  

>25 and <50 

This criterion applies to a Number field, such as Price or 

UnitsInStock. It includes only those records where the Price or 

UnitsInStock field contains a value greater than 25 and less than 

50. 

DateDiff ("yyyy", 

[BirthDate], Date()) 

> 30 

This criterion applies to a Date/Time field, such as BirthDate. 

Only records where the number of years between a person's 

birthdate and today's date is greater than 30 are included in the 

query result.  

Is Null 
This criterion can be applied to any type of field to show records 

where the field value is null.  

As you can see, criteria can look very different from each other, depending on the 

data type of the field to which they apply and your specific requirements. Some 

criteria are simple, and use basic operators and constants. Others are complex, and 

use functions, special operators, and include field references. 

This topic lists several commonly used criteria by data type. If the examples given in 

this topic do not address your specific needs, you might need to write your own 

criteria. To do that, you must first familiarize yourself with the full list of functions, 

operators, special characters, and the syntax for expressions referring to fields and 

literals. 

Here, you will see where and how you add the criteria. To add a criteria to a query, 

you must open the query in Design view. You then identify the fields for which you 

want to specify criteria. If the field is not already in the design grid, you add it by 

either dragging it from the query design window to the field grid, or by double-clicking 

the field (Double-clicking the field automatically adds it to the next empty column in 

the field grid.). Finally, you type the criteria in the Criteria row 

Criteria that you specify for different fields in the Criteria row are combined by using 

the AND operator. In other words, the criteria specified in the City and BirthDate fields 

are interpreted like this: 
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City = "Chicago" AND BirthDate < DateAdd (" yyyy ", -40, Date())  

 

 The City and BirthDate fields include criteria. 

 Only records where the value of the City field is Chicago will satisfy this 

criterion. 

 Only records of those who are at least 40 years old will satisfy this criterion. 

 Only records that meet both criteria will be included in the result. 

What if you want only one of these conditions to be met? In other words, if you have 

alternate criteria, how do you enter them? 

If you have alternate criteria, or two sets of independent criteria where it is sufficient 

to satisfy one set, you use both the Criteria and the or rows in the design grid. 

 

  

 

 

 

Self-Check -3 Written Test 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 
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           1 - A criterion is similar to (2) 

a. a formula  

b. String 

c. A&B 

            2.- is a string that may consist of field references, operators, and constants(2) 

                        A. Criterion 

                        B. Value 

 

 

  

 

 

 

 

 

 

 

 

Information Sheet 4 Selecting & Displaying Data 

4.1 Introduction 

          Data selection is defined as the process of determining the appropriate data 

type and source, as well as suitable instruments to collect data. The primary objective 

of data selection is the determination of appropriate data type, source, and 

instrument(s) that allow investigators to adequately answer research questions. 

4.2 The function of displaying data 

 Displaying data in research is the last step of the research process.  

 It is important to display data accurately because it helps in presenting 

the findings of the research effectively to the reader. 

  To make the findings more visible and make comparisons easy. 

Note: Satisfactory rating - 2 and 4 points          Unsatisfactory - below 2and 4points  

You can ask you teacher for the copy of the correct answers. 
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Self-Check -4 Written Test 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

1. --is defined as the process of determining the appropriate data type and         

          Source (2) 

       A. Data selection 
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       b. Data processes 

       c. A&B 

2.- It is important to display data accurately(2) 

        A. True 

        B. False 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Operation Sheet-1 Accessing &Locating Records 

 

Note: Satisfactory rating - 2 and 54points          Unsatisfactory - below 2 and 4points  

You can ask you teacher for the copy of the correct answers. 
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Steps to Browse through all recordsYou can browse through records by using 
the TAB key when you want to move through one record at a time, in 
order, to locate a specific record. You can also browse through records in 
a table in Datasheet view using the record navigation buttons. The record 
navigation buttons are available at the bottom of the table or form. 

 

1. Go to the first record 

2. Go to the previous record 

3. Current Record box 

4. Go to the next record 

5. Go to the last record 

6. Open a new (blank) record 

7. Filter indicator 

8. Search box 

Steps to Search for a specific record 

 Open the table or form, and then click the field that you want to search. 

 On the Home tab, in the Find group, click Find, or press CTRL+F.  

The Find and Replace dialog box appears, with the Find tab selected. 

 In the Find What box, type the value for which you want to search. 

 To change the field that you want to search or to search the entire underlying 
table, click the appropriate option in the Look In list. 

 In the Search list, select All, and then click Find Next. 

 When the item for which you are searching is highlighted, click Cancel in the 
Find and Replace dialog box to close the dialog box. Records that match your 
conditions are highlighted  

Steps to Create a query to find a specific record 

 On the Create tab, in the Queries group, click Query Design. 

 In the Show Table dialog box, double-click Issues, and then click Close. 
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 In the query designer, double-click the asterisk (*) in the Issues table. This 
helps make sure that the query will display all the fields from the records it 
returns. 

Issues.* appears in the first column of the design grid, in the Field row. This 
indicates that all the fields from the Issues table should be returned. 

 In the query designer, double-click Status on the Issues table. 

Status appears in the second column in the design grid, in the Field row. 

 In the second column of the design grid, clear the check box in the Show row. 
This helps make sure that the query does not display the Status field. 

If you do not clear the Show check box in the Status column, the Status field 
will be displayed two times in the query results. 

 In the second column of the design grid, in the Criteria row, type ="Closed". 
This is your search criterion. This is how you make sure that the query will 
return only those records where the value of Status is "Closed." 

Note: In this example, only one search criterion is used. You can use many 
search criteria for any given search by adding criteria to more fields, and by 
using the  

 On the Design tab, in the Results group, click Run. 

Note: Unless you have already begun tracking issues and therefore have data 
in the Issues table — and you have set the status of at least one issue to 
"Closed" — the query will not return any results. However, you can save the 
query, and use it at any time in the future. 

 Press CTRL+S to save the query. 

 In the Save As dialog box, type a name for the query in the Query Name field, 
such as Closed Issues, and then click OK. 

 

 

 

Operation Sheet-2 Creating Simple Query to Retrieve Information 

 

 The simplest way to create a query is by using the Query Wizard. It presents a list of tables and 
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queries you can select from the current database. 

StepsTo use the Query Wizard, 17 

1. on the Ribbon, you can click the Create tab and, in the Other section, click Query 
Wizard . This would display the New Query dialog box: 

 

2. On the New Query dialog box, you can click Simple Query Wizard and click OK. The first page 
of the Simple Query Wizard expects you to choose the origin of the query as a table or an 
already created query. After selecting the table or query, the second page of the wizard would 
present the fields of that list and you can select those you want: 

 

The next page of the wizard allows you to specify the name of the query: 

 

 

 

 

 

Steps to create  Query in Design view 

 
Like other objects of a database, a query can be designed. You design a query using the Design 
View: 
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 To display a query in Design View, from the Navigation Pane, you can right-click a query and 
click Design View 

 To start designing a new query, in the Other section of the Create tab of the Ribbon, click 
Query Design 

This would display the Show Table dialog box that allows you to specify the table or query that 
holds the fields you want to use in the intended query 

 

  If the Show Tables dialog box is closed or for any reason you want to display it: 

 In the Query Setup section of the Design tab of the Ribbon, you can click the Show Table 

button  

 You can right-click anywhere on the query window and click Show Table... 

When a query is displaying in Design View, the Design tab of the Ribbon displays the buttons 
used for a query:  
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The Query Window 

 
The Query window allows you to design and manage various aspects of a query. You can right-
click the title bar of the Query window to access a menu: 

 

One of the operations you can perform on the Query window consists of resizing its top and 
bottom sections by dragging the splitter bar up or down: 
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Selecting the Columns 

 
To create the fields for a query, you use the table(s) or query( queries) displayed in the upper 
section of the window. Once you have decided on the originating object(s), you can select which 
fields are relevant for your query: 

 To select one field from the list, just click it 

 To select many fields on the same range, you can click one of them, press and hold Shift. 
Then click one field on the other end of the desired range 

 To select fields at random, click one of the desired fields, press and hold Ctrl; then click each 
one of the desired fields 

 To select all fields, you can click the * line on the list of fields 

To Add Columns 

 
To make a field participate in a query, you have various options: 

 Once you have made your selection on the list in the top part of the query window, you can 
drag it and drop it in the bottom section of the query window 
  

 

 You can also select more than one field and drag them: 
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 Instead of dragging a field or all fields, you can either double-click a field to add it to the 
query, or double-click the line with * to add all fields to the query 

 In the bottom part of the query window, click an empty Field box to show a combo box. Then 
click the arrow of that combo box and select an item from the list: 
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Executing a Query 

 
To execute a query: 

 If the query is currently closed, from the Navigation Pane: 

o You can double-click it 

o You can right-click it and click Open 

 If the query is already opened and it is in Design View, on the Ribbon: 

o You can click the Run button  

o  You can click the View button  or you can click the arrow of the View button 
and click Datasheet View 

If you manually write a SQL statement and want to execute it, change the view to Datasheet 
View. 

Selecting a Column 

 
Some operations require that you select a column from the bottom section of the query window: 

 To select a field in the lower section of the view, click the tiny bar of the column header: 
  

 
 
The whole column will be selected 
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 To select a range of columns, click the column header of one at one end, press and hold 
Shift, then click the column header at the other end 

Since selecting a column in the Query window is a visual operation, there is no equivalent in SQL. 

Removing a Column From a Query 

 
As seen above, a query is built by selecting columns from the originating list and adding them. If 
you do not need a column anymore on a query, which happens regularly during data analysis, 
you can either delete it or replace it with another column: 

 To delete a column: 

o Once it is selected, you can press Delete 

o Right-click the column header and click Cut 

 To delete a group of columns, select them and press Delete 

Replacing a Column 

 
To replace a column, click the arrow on the combo box that displays its name and select a 
different field from the list: 

 

Moving a Column 

 
Columns on a query are positioned incrementally as they are added to it. If you do not like the 
arrangement, you can move them and apply any sequence of your choice. Before moving a 
column or a group of columns, you must first select it. Then: 

To move a field 

1.  click its column header once.  
2. Click it again and hold your mouse down,  
3.  drag in the direction on your choice 
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To Create a select query in a desktop database: 

 Click Create > Query Design. 

 In the Show Table box, double-click the Products table > Close. 

 To add the fields to the design grid, double-click the Product Name and List 

Price fields. 

 In the criteria row, under List Price add a criteria. For example, >=10 to 

show a list of products more than or equal to $10.00. 

 

5. To see the query results, on the Design tab, click Run. 

  

 

4. To move a group of columns, first select the group and then proceed as if it were one 
column 
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Steps To Create an Append Query 

1. Click the QUERY DESIGN icon (located in the OTHER group of the CREATE 

ribbon).   The QUERY DESIGN window then opens along with the SHOW 

TABLE dialog form.    

2. The next step is to add tblMoreNames to the QUERY DESIGN window.  Do 

this by clicking ADD in the SHOW TABLE dialog form.  Notice it is the table 

containing the data to behappended that we have selected. 

3. Click the APPEND icon from the QUERY TYPE group of the DESIGN ribbon. 

 As you do this, you will see the APPEND dialog box open. 

4. You are now asked to select the name of the original table to which the new 

data is to be appended. So select tblContacts from the drop down list.   

5. You are also asked whether this table is stored in the current database or in an 

external database. In this exercise both tables are stored in the current 

database.  This is the default button displayed in the option group, so there 

should not be any need to change it. 

6. Click OK to close the dialog box. 

7. Next we are going to select the fields from tblMoreNames to be appended. To 

do this drag and drop the Initials and LastName fields from the table (in the 

top half of the window) down onto the design grid. 

8. Next we are going to tell Access which fields the data 

from Initials and Lastname will be appended to.  To do this go down to the 



 FTVET Agency                                                                                                               

Training, Teaching and Learning Materials Development                                          

TTLM Development Manual               Date:  10-2019     
    
3rd Revision                  Author:   FTVET AGENCY                  Page 26 of 
50 
  

APPEND TO row of the design grid (see figure 3 below), and 

]select FirstName in the Initials column, and Surname in 

the LastName Column. 

 

Figure 2: The Query Design Grid. 

9. We could add query criteria at this stage, but this particular exercise does not 

require any.  If we did, however, this is added in the CRITERIA row just like it 

is with a select query.  

10. If you want to view the data that is going to be appended, click the VIEW icon 

from the RESULTS group of the DESIGN ribbon.  It is especially important to 

do this if any if any criteria is applied in step 9 above. 

11. Once you are satisfied the correct data is going to be appended, click the RUN 

icon, again from the RESULTS group of the DESIGN ribbon. 

12. A dialog box opens informing us that 10 rows are going to be appended, and 

asking us to confirm that we want to go ahead with this operation.  Click YES 

to complete. 

To see the result of our Append Query, re-open tbl Contacts.   

 

 

http://4.bp.blogspot.com/-CBbzggDOBTo/Txk5YW_IHKI/AAAAAAAAApk/VK10P9AAwfs/s1600/design-grid.JPG
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Steps to Create Delete Query 

1. Open the Employees table. 

It should open and look like this: 

 

Note that Tom Gumman and Tina Gumman are currently employees. 

2. Close the table. 

http://1.bp.blogspot.com/-gdgGH957zNQ/Txk-rPgcY_I/AAAAAAAAAps/0vxUJGMCyOQ/s1600/appended-data.JPG
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3. Click the Create tab. 

In the Ribbon, click Query Design. 

4. When the Show Table window appears, click Employees. 

Then click the  button. 

5. Click the  button. 

6. In the Ribbon, click Delete. 

 

 

To Add  fields 

1. In the field list of the Employees table, click-and-drag the * field to the 

first column of the design grid. 
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2. Release the mouse button. 

The query design grid should look like this: 

 

3. In the field list of the Employees table, double-click the Last Name field. 
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The query design grid should now look like this: 

 

 

 

 

To Add criteria 

1. In the Last Name column of the design grid, click in the Criteria row. 

2. Type:Gumman then press the ENTER key. It should look like this: 

 

3. In the Ribbon, click Run. 

When the alert window appears, click the  button. 

TIP: Be careful when designing Delete queries. Once a record is deleted, 

the deletion cannot be undone. 

You may want to run the query as a regular query first, to verify it's 

choosing the correct records, and then switch the type to a Delete query. 

4. On the Title Bar, click the  icon. 

5. When the Save As window appears, type: 
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Delete Old Employees 

in the Query Name box. 

 

6. Click the  button. 

7. Close the query window. 

 

To Verify The  results 

1. Open the Employees table.It should look like this: 

 

Note that Tom Gumman and Tina Gumman are no longer listed as 

employees. 

2. Exit Microsoft Access. 

 

Example 2 

Stage 1 - Creating the initial Select Query 

1. Select the CREATE TAB of the Access Ribbon. 
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2. Click the QUERY DESIGN icon.  It is located in the OTHER group of the 

CREATE ribbon. 

3. Select tblContacts from the SHOW TABLE dialogue box. 

4. Drag the asterix (*) from tblContacts down to the first column of the DESIGN 

GRID.  This is a way of getting the query results to display all fields from the 

table without having to select each one individually. 

5. Then Drag the Company field from tblContacts down to the second column of 

the grid.  We have added this field separately because we are going to enter a 

criteria in this column. 

6. Click on the CRITERIA row of the Company column, and add the 

criteria: "Company 5" 

The Select Query has now been created.  It should look like this: 

 

 

 

 

 

 

 

Figure 2: The Select Query created in the first stage of the Delete Query. 

It is advisable to run the query at this point and check the results are correct.  They 

should look like this: 

 

 

Figure 2: The results from the Select Query. 

http://4.bp.blogspot.com/-v6Ig7ED5AP0/Tl_OVKqsQuI/AAAAAAAAAfY/8u3nV4ILvVo/s1600/query-criteria.JPG
http://3.bp.blogspot.com/-n5SCeu2k86A/Tl_Pj-E49YI/AAAAAAAAAfc/FiR3At9XxzU/s1600/select-query-results.JPG
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As you can see, our select query has found four records from tblContacts matching 

the criteria of Company 5".  Since this is the correct result for the dataset we are 

working with,  we can move onto the second stage of the process: converting 

the Select Query to a Delete Query. 

Stage 2 - Converting the Initial Select Query to a Delete Query 

1. If you look at the QUERY TYPE group of the DESIGN ribbon, you will notice 

that the SELECT QUERY icon is highlighted orange.  We need to change this 

to DELETE QUERY.  To do this just click the DELETE QUERY icon further 

along the group.   

 

Figure 3: The QUERY TYPE group of the DESIGN ribbon. 

The DELETE QUERY icon is highlighted orange. 

2. After clicking the DELETE icon, you will notice that the row of SHOW tick 

boxes disappears from the DESIGN GRID, along with the row for SORT. A 

new row entitled DELETE has taken their place.  Access has filled in the 

values of FROM and WHERE in the first and second columns respectively. 

 These are SQL Keywords: the FROM keyword indicates the first column 

contains fields from tblContacts, and WHERE indicates the Company column 

contains a criteria against the data stored in this field.  

http://ms-access-tips.blogspot.com/2011/05/gentle-introduction-to-access-sql.html
http://4.bp.blogspot.com/-xj2UjuGficg/TmD6DOOJFBI/AAAAAAAAAfs/dppRNP3VXN0/s1600/query-type-group.JPG


 FTVET Agency                                                                                                               

Training, Teaching and Learning Materials Development                                          

TTLM Development Manual               Date:  10-2019     
    
3rd Revision                  Author:   FTVET AGENCY                  Page 34 of 
50 
  

 

Figure 4: The QUERY DESIGN GRID for our 

DELETE Query.  Notice the new row for DELETE 

containing the SQL FROM and WHERE 

Keywords. 

3. Click RUN from the QUERY RESULTS group.   

4. Click YES when prompted whether we want to delete the number of rows 

matching our query criteria.  This will be four rows for the dataset we have 

been working with. 

We can now go back and open the tblContacts table.  As you can see from Figure 5 

below, all Company 5 contacts have been removed by our DELETE QUERY. 

 

http://4.bp.blogspot.com/-cmraercP0V8/TmCD-3X4IgI/AAAAAAAAAfg/zuuj9awEkR8/s1600/delete-query-design.JPG
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Steps to Create Make table Query 

Using our scenario, we will create a make-table query for all customers from the 

specified area that have ordered products in the past 12 months. We will need to 

perform the following steps to create the query: 

 

 

 

 

 

 

http://4.bp.blogspot.com/-S6dGLBD45Tg/TmEDFSGabQI/AAAAAAAAAfw/Cl-1aryMYDk/s1600/records-deleted.JPG
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1. Create a new query, by using   the Customers and Orders tables. 
 

Steps to 

2. From the Query Type button  on the toolbar, select Make 

Table  
 
The Make Table dialog box appears, where you should enter the name for the 
new table. Here we can also select whether we want to create the new table in 
the current database or in another database. Ensure that the current database is 
selected and click OK. 
 

 
3. Select the mailing information fields, in our case CustomerTitle, CustomerName, 

Address, City, Postcode from the Customers table, and OrderDate from the 
Orders table. 

4. Specify the chosen City criteria in the City field and add the criteria required in 
the OrderDate field to only show records from the last 12 months - using 
the DateAdd function: >=DateAdd("yyyy",-1,Now()) 
 
The query design should appear like the example below: 

http://www.databasedev.co.uk/dateadd_calculation.html


 FTVET Agency                                                                                                               

Training, Teaching and Learning Materials Development                                          

TTLM Development Manual               Date:  10-2019     
    
3rd Revision                  Author:   FTVET AGENCY                  Page 37 of 
50 
  

 

 
5. To check that the results are returned that we expect, click on the datasheet 

button  on the toolbar. Once you have verified this, switch back to query 
design view. 

6. In query design, deselect the Show: property for the OrderDate field, as we do 
not need this to be visible in our new table. 

7. Click on the Run button  on the toolbar. Microsoft Access now displays a 
message to indicate how many records will be copied to the new table. 
 

 
8. Click Yes to complete the query, and create the new table. 

 

 

 

 

 

Using an Update Query Example 1 
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1. When the Show Table window appears, select the tables that you wish to use in 
the query 

2. Click on the Add button. When you have finished adding your tables 
3.  Click on the Close button. 

In this example, we've selected the Big and Bot tables. You can select multiple tables 
by holding down the Ctrl key while selecting the table names. 

 

4. Next, right-click somewhere next to the tables (but not on a table) in the query 
editor,  

5.  select Query Type > Update Query from the popup menu. 
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6. Next, build the query like the one below: 

 

This query will update the MFG field in the Bot table with the value in the MFG field in 
the Big table when the PART values match. 

The SQL for this query is as follows: 
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UPDATE Big INNER JOIN Bot ON Big.PART = Bot.PART 

SET Bot.MFG = [Big].[MFG]; 

Example 2 

Here are the steps that we follow to produce the required outcome: 

1. Create a new query using the Products table and the Suppliers table. Include the 
fields that you are going to use to update the data (ProductID, ProductName and 
UnitPrice from the Products table, and CompanyName from the Suppliers table) 
 
We have also included criteria in the CompanyName field to limit the results to 
only those of the Supplier that we are updating the records for. 
 
Also, in the image below, you will see that we have included an additional field, 
just to test our expression. This will give us a value for the 3% increase, just to 
check that the results will be returned correctly. This field will be removed before 
we run the update, but we will use the expression later. 
 

  
Creating a SELECT query, that will later be changed to the UPDATE Query 

2. To check what results this will produce, run the query by clicking on the 

datasheet button 
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Checking the results before running the Update Query 

3. When we are happy with the resulting data, we can switch back to design view to 
convert the query to an Update query. 
 

From the Query Type button  on the toolbar, select Update 

Query  
 
In the curUnitPrice column, in the Update To cell, type in the 
expression[curUnitPrice]*1.03 and press enter. This expression will update the 
original Unit Price by 3 Percent. 
 
The query design should now look like: 
 

  
The Update Query design 

4. We now need to Run this query, using the Run button  to update the data in 
our Products table that meets the criteria that is applied. The warning dialog box 
indicates the number of records that will be update, click Yes to accept this: 
 

 

Example 3 
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1. Open the Products table. 

2. Note the price (to customers) of French Truffles ($8.99) and Blue 

Mountain Coffee ($9.99). 

 

3. Note the cost (to the store) of French Truffles ($6.15) and Blue Mountain 

Coffee ($8.00). 

 

4. Close the Products table. 

5. Make sure the Create tab is selected. 

In the Ribbon, click Query Design. 

6. When the Show Table window appears, click Products. 

7. Click the  button. 

The query window should look like this: 
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8. In the Ribbon, click Update. 
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Then click the  button. 

10. In the field list of the Products table, scroll down and double-click 

the Price field. 

 

The query design grid should now look like this: 

 

11. In the Price column, click in the Update To row. 
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12. Type: 

[Cost]*1.25 

 

Then press the ENTER Key. 

TIP: Make sure that you've enabled all content in the database. To do 

that, click the  button if the Security Warning bar is showing. 

This will raise prices for all products by 25%. 

TIP: The square brackets [ ] tell Access that Cost is a field. 

 

 

13. In the Ribbon, click Run. 

14. In the Title Bar, click the  icon. 
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15. When the Save As window appears, type: 

Update Product Prices 

in the Query Name box. 

 

Then click the  button. 

16. Close the query window. 

To Verify results 

1. Open the Products table. It should look like this: 

 

 

Note the updated price of French Truffles ($7.69) and Blue Mountain 

Coffee ($10.00). 

2. Close the Products table. 
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 Parametric Query 

Example 1 

1. View the query in design view 
2. In the criteria cell for the appropriate field(s), type in the desired expression within 

the square brackets([ ]) 
 
For example, using a parameter to query for date valWhen the query is run, 
Microsoft Access displays this text to prompt the user for the criteria. The text of 
the prompt must be different from the field name, although it can include the field 
name. 

3. Run the parameter query 
4. When you are prompted to enter a parameter value, enter the value of the data 

that you want to view and click OK.: 

 

Steps To create and run a parameter query: 

1. Create a query as you normally would, modifying the table joins if 

necessary, selecting the fields to include in your query, and adding any 

nonvariable criteria to the appropriate fields in the Criteria: row. 

2. Locate the field or fields where you would like the variable criteria to 

appear, and place your cursor in theCriteria: row. 

3. Type the phrase you would like to appear in the prompt that will pop up 

every time you run your query. Make sure to enclose the phrase in 

brackets [ ]. For example, in our parameter query that searches for 

orders placed on a certain date, we might type our criteria like 

this: [What date?]. 

4. On the Query Design tab, click the Run command to run your query. A 

dialog box will appear with the prompt you specified. Enter your search 

term, then click OK to view your query results. 
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To run an existing parameter query, simply open it. 
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Name: ______________________________________  Date: 

________________________________________ 

  

Time started: _______________________________ Time finished: 

______________ 

 

 Tsak1. Perform the following by using a navigation button 

 Go to the first record 

 Go to the previous record 

 Current Record box  

 Go to the next record 

 Go to the last record 

 Open a new (blank) record 

 Task.2 Create Query  

 Create query using query button 

 Create query using query wizard 

 Create  the following types of queries 

 Create Select Query 

 Create Action Query 

 Create Append Query 

 Create Update Query 

 Create Make table Query 

 Create Delete Query 

 

 

Creating Database Queries 

 

LAP Test 
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